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O Homer file formats

O Basic processing :
¢ Intensity to hemoglobin concentrations
¢ Filtering
¢ Block-averaging

O More advanced processing :
¢ Other useful Homer functions
O Exporting results
¢ Plot probe
¢ Group analysis



File formats

Probe source-detector geometry : .sd files

fNIRS experimental data . .nirs files

fNIRS experimental data* . .shirf files (new)
Data processing stream . .cfg files

Processed data files . groupResults.mat



.SD file format

Describes the 2D source/detector geometry
Matlab .sd file containing the structured variable SD with the following fields:

Field Definition Size Example
Lambda Wavelengths used for data acquisition 1 X Nyavelengths [690 830]
nSrcs Number of sources 1x1 1
nDets Number of detectors 1x1 2
SrcPos Array of source coordinates nSrcs x 3 [0 O O]
DetPos Array of detector coordinates nDets x 3 [30 0 O;
030 0]
MeaslList List of measurement channels Nchannels X 4 [1111;
column1 column 2 column 3 column 4 1211
source idx detectoridx  unused wavelength idx 1112;
1212]

Note: The SD structure is also incorporated in the .nirs file format we will see in a few slides



.SD file format: the SDqui

Enables you to create your own .sd files

B SDgui (v1.2.7) - W:\1\users\mayuce\MCI\PROBE
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.SD file format: the SDgui

Start AtlasViewer

AtlasViewerGUI (v2.1) - C:\Users\mayucel\Documents\PROJECTS\COURSES\2016_fNIRS_Course\fNIRS_COURSE_2016\Myworkingcopy\Ex4_Probe_design\SetA\A2 o[ B[S
File l Tools | Forward Model Image Recon

{"7 \c Choose Labels Cglormap . .
Make Probe g u |

Import Probe

Convert .ezs to Dig Points

Find Ref Points

Register Atlas To Dig Points
Register Atlas to Head Size
Calculate Ref Points 4
Lighting »
View Origin

Probe Placement Variation
Calculate Optical Properties
Project Probe To Cortex »

Hb Conc Overlay

Display/Register
Brain Display Head Opacity | Rotate/Zoom Axes Probe Image Uisplay

B pPi Register Probe to Surface

(o] Jratk] iy | bocer
Rot L

o Lavels ey o rere L > 10 Colormap Thresh 1e-05 1e-05
< ] { 10 } [ > ] Copy [V] Hide Springs

@ Show Head M @
[ ] Show srcsidets Channel

ShowRefPts ——— [¥] Hide Dummy Opts
‘ E [] view optodes as circles Condition

) Labels () Circles ) )
. - [V] Hide Meas List

Show Dig Pts Display MNI Projection




SDgul
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How to start

1. Begin by naming the new probe using the
text box at the bottom-center of the GUI

2. Enter the wavelengths of light that will be
used in the experiment (690 830)

Hint: easier if you have your 2D desigh on a
piece of paper with the di.stances eg:

2 0,30,0
€ Wl
= ] :
o :
b :
v 4



Adding sources, detectors and channels

. Place a source at (0, 0, 0)

4. Add detectors at (30, 0, 0) and (0, 30, 0)

. Connect measurement channels by clicking
on optodes

— to remove a channel do the same

— YOu cannot connect two detectors or two sources
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NIRS file format

Contains an fNIRS dataset
Matlab .nirs file containing the following variables:

Field Definition Size

SD Probe geometry, same as .sd files Structured variable

t Array of data time points Nime_points X 1

d Array of raw intensity time course Nime_points X Nchannels

S Array of stimulus onsets. Different conditions are N-Time_points X Nconditions
a way to separate stimuli into different groups

aux Array of auxiliary signals N-time_points X Naux channels

Note 1: In addition to the above parameters, additional parameters can appear in the

.nirs file as a result of processing the data set in HOMER3.

Note 2: Conversion scripts are available for some other data formats (Hitachi, NIRx,

Shimadzy, ...), see http://homer-fnirs.org/faq/



.SNIRF file format

« many different fNIRS data file format

« difficult to use specific data analysis software and share
data with collaborators

« Common format: Shared Near InfraRed File Format
http://github.com/fNIRS/snirf

* SNIRF provides numeric fNIRS data with time stamps
and a so-called ‘measurement list’ for detailed
measurement information (ir 5NES farmeat)

Shared Near Infrared File Format V1.0 Specification

* Document Version: Draft 3

® License: This document is in the public domain.

Table of Content
Finally, we have launched a SNIRF list server. The relevant addresses are here:

e Introduction

e SNIRF file specification
o SNIRF data format summary

Mail list: snirf@fnirs.org . .
o SNIRF data container definitions

n formatVersion
Help address: snirf-help@fnirs.org s nirs

= metaDataTags
Subscription address: snirf-subscribe@fnirs.org » data

= data.dataTimeSeries
Unsubscription address: snirf-unsubscribe@fnirs.org a datatime

= data.measurementList
= data.measurementList.sourcelndex

= data.measurementList.detectorindex



.CFG file format

A .cfg file describes the steps of data analysis, a sequence of [glel\VISXERV[sTale]s}

Simplest processing stream: Multiple more advanced functions
Intensity we can incorporate in the stream:

Intensity to AOD R hort
:
SD
AOD
segments

AOD to

Concentration Remove /
Band-pass filter Correct MAs

Concentration

A

Block- average

Hemodynamic
response function Note: In options, you can hover over each function

(HRF) to get help on the function and the parameters



.CFG file format: the Process Stream GUI

The Process Stream GUI enables you to create your own .cfg files

(4] Homer3 (w1.14.1) - chjdubbiworkspaces — [m] X
File Tools View Chaved LIAamrsanr?d y
Edit Stimulus SLAlI L TIVIIICI D
Edit Processing Stream . 1r .
Go to Tools > Edit Process Stream -» it starts procStreamGUI
Display P-Values 09r
0.8 0.8 1
0.7 07}
0.6 - 0.6
0.5 051
041 041
0.3 031
02 021
01 B 01 L
0 Il 1 1 1 1 1 1 1 1 J 0 L L L L )
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1 0 0.2 0.4 0.6 0.8 1
Current Processing Element Motion Artifacts
Processing Level ﬂl [ Show Excluded Manual [ ]Exclude Time

) Group Edit Options | Applyto all [] Show Excluded Auto

[] Show Excluded by Chan

() Subj Plot Type Select Plot Window
Pan Left/Right

() Run (") Raw Data W HRF < | > | Reset View
(10D \ - [JFix X-range
0 400
() Conc Aux

File Error; Status; [JFix Y-range
| -

<




C F G fi | e fo rm a Add, remove, and move function The processing stream
. usages in processing stream you’re creating

Edit Processing Stream \ 1 [ I

User functions | [ & secsueamon - o «x
registry: The list | |« Function names  Possible usages for function Function usages >
|

of functions to Run P Groun
Choose from Registry Functions Usage Options

Current Processing Stream

hnrPR _BandpassFilt
hurP Blockhwvy Add
hmrR_GLM

hurR IntensityZ0D

hurPR_Motiondrtifact Delete

0.6

0.5

hurP MotiondrtifactByChanne
hurP MotionCorrectChsi
0.4 - hurP MotionCorrectPCA
hurP_ MotionCorrectPCArecurs:
> hurP MotionCorrectRLOESS
0 3 | hurP MotionCorrectSpline
. hurP MotionCorrectSplineSG
hnrPR MotionCorrectWavelet
hmrR 0DZConc
hurR 0DZConc_new
hmrP PCAFilter
hurP PruneChannels
0-1 hurP StimPejection

0.2

0 0.1 0.2 v Exit

A

dataZ = hmrP BandpassFilt{ data, hpf, lpf )}

UL NAME: me
Bandpass_Filter

DESCRIPTION:
Perform a bandpass filter on time course data.

INPUT:
data - SNIRF data type containing data time course to filter, time
vector, and channels.
hpf - high pass filter frequency (Hz)
Typical walue is 0 to 0.0Z.
1pf - low pass filter frecuency (Hz)
Typical walue is 0.5 to 3.

Eile Error Status:

22



.CFG file format

Intensity

z procStrearnGUI

File -~
Intensity to , r4
Run Subject Group
AO D Registry Functions Usage Options Current Processing Stream
hurP_BandpassFilt | Intensity_to
hurR_Blockivy

Add
hurR_GLM

AOD

hnrR_Motionhrtifact Delete
hmrR_MotionhrtifactByChannel
hmrR MotionCorrectChsi

hmrR MotionCorrectPCA
hmrR_MotionCorrectPCArecurse
hmrR_MotionCorrectRLOESS
hmrR MotionCorrectSpline
hurR MotionCorrectSplineSG
hurR_MotionCorrectWavelet
hmrR_0DZConc

hmrR 0DZConc_new
hmrR_PCAFilter
hmrR_PruneChannels

hmrR StimRejection

[ petete |

Save

U

dod hmrP_IntensityZ0D{ intensity )

UI NAME:
Intensity_to_Delta 0D

DESCRIPTION:
Converts intensity data to optical density

INPUT:
intensity - SNIRF data type where the d matrix is intensity

OUTPUT:
dod - SNIRF data type where the d matrix is change in optical density

USAGE OPTIONS:
Intensity_to_Delta 0D: dod = hurP IntensityZ0D(data)




.CFG file format

4 procStreamGUI = O X

File Y

Run Subject Group

Registry Functions Usage Options

hurR BandpassFilt Bandpass_ Filter

hnrR_ IntensityZ0D Intensity to_Delta 0D
hurR Blocklvy Add hurR_BandpassFilt : Bandpass_Filter

hurR_ GLM
hnrR_Intensity20D Delete \ /
hurP Motiondrtifact

hurR MotiondrtifactByChannel
hurR MotionCorrectChsi

hurR MotionCorrectPCA

hurR MotionCorrectPCArecurse
hurR MotionCorrectRLOESS
hurR MotionCorrectSpline
hurR MotionCorrectSplineSG
hurR MotionCorrectWavelet Load
hunrR_0DZConc °
emrli ODECanc nuw Processing stream:oaded

hurR PCAFilter

hurR_PruneChannels from default Config file.
R SramReseren Start fresh with an empty

v processing stream‘by

{01

e —

Clear All

SYNTAX:

dataZ = hmrR BandpassFilt{ data, hpf, L\

UI NAME:
Bandpass_Filter

DESCRIPTION:
Perform a bandpass filter on time course data.

INPUT:
data - SNIRF data type containing data time course to filter, time
vector, and channels.
hpf - high pass filter frecquency (Hz)
Typical walue is 0 to 0.0Z.
lpf - low pass filter frecquency (Hz)
Typical walue is 0.5 to 3. v




.CFG file format

Your GUI should look like this now,
with no entries in Current Processing
Stream window

(4 procStreamaGUl — O X
File N
Run Subject Group
Registry Functions Usage Options Current Processing Stream
hurP BandpassFilt A ~
hurE Blockiwvy
hurP_GLM

hurE_IntensityZ0D

hurPE Motiondrtifact

hurP MotiondrtifactByChannel
hurE MotionCorrectChsi

hurR MotionCorrectPCA

hurE MotionCorrectPCArecurse
hurE MotionCorrect RLOESS

hurPE MotionCorrectSpline
hurE MotionCorrectSplineSG
hurR MotionCorrectWavelet
hurR_0DZConc Load
hurPE 0DZConc_new
hmrR_PCAFilter

hurE PruneChannels
hurP_StimPejection

Delete

<

v

dod = hmrP_IntensityZ0Di{data) A




.CFG file format

Intensity ? ProcStreamEditGUL (1.14.2) - cyjdubblworkspacesisubjectsifnirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysis\1-basic-steps — O X
File N
Intensity to Run Subject Group
AO D Registry Functions Usage Options Current Processing Stream

hnrR_Intensit 3 Delta 0D
hurP BandpassFilt : Bandpass_Filter

huwrR_O0DZConc : Delta 0OD_to_Conc

hurR Blockiwvy
hurP_GLM

AOD hurP_IntensityZ0D Delete hurP_Elockivy : Block_Average on Concentration
huwrP Motiondrtifact \
hurP MotiondrtifactByChamnnel

hurR MotionCorrectChsi
hurP MotionCorrectPCA Up ‘
Ba nd_pa SS hmrP_MotionCorrectPCArecurse v :
. hmrR_MotionCorrectRLOESS Down Ad d o
fl Iter hurR MotionCorrectSpline ' °

hurR MotionCorrectSplineSG

bed_oxionCorzaccBaveier ~ | | o hmrintensity20D

huwrR_0DZConc_new Save °
. hmrE_PCAFilter ™ hm B d F It
AOD, flltered huwrR PruneChannels r an pa SS I |
hurR StimRejection z :
“¢  hmrOD2C 3
) mr onc
. s Exit Clear All
AOD to ° 8
~
Concentr‘at|on data? = hurl_BandpassFilt{ data, hpf, lpf )
UI NAME:
Bandpass_Filter
. DESCRIPTION:
concentratlon Perform a bandpass filter on time course data.
INPUT:
data - SNIRF data type containing data time course to filter, time
vector, and channels.
BIOCk— hpf - high pass filter frecuency (Hz)
Typical walue is 0 to 0.0Z.
average lpf - low pass filter frecquency (Hz)
Typical walue is 0.5 to 3. v

Hemodynamic

response
function (HRF)



.CFG file format

File

;E Procs

reamEditGUI: (1.14.2) -

\fhirs-cours

NEx1_Basic_data_analysis

Run Subject Group

Registry Functions

hurR Blockdvy

hurP_GLM

hurR_IntensityZ0D

hurR Motiondrtifact

hurR MotiondrtifactByChannel
hurR MotionCorrectChsi

hurR MotionCorrectPCA

hurR MotionCorrectPCArecurse

Usage Options

Add

Delete

hurR MotionCorrect RLOESS
hurR MotionCorrectSpline
hurR MotionCorrectSplineSG
hurP MotionCorrectWavelet
hurR 0DZConc

hurPR 0DZConc_new

huwrP PCAFilter

Down

Current Processing Stream

hurR_IntensityZ0D : Intensity_to_Delta 0D A
hurP BandpassFilt : Bandpass_ Filter
hurP_ 0DZConc : Delta 0D _to_Conc

hurR_ PruneChannels
hurR_StimRejection

< >

[dedvy, dolAwgltd, nTrials, deSumZ)] 3
trange: [-Z.0, Z0.0]

i

(4] MENU

Save to current processing stream or config file? ELEG

’ Current processing stream ‘

Config file

‘ Cancel




.CFG file format

[ procstreamGUI - a X
File (4 Process Options Config File to Save To? X ~
B M <« Ex1_Basic_data_analysis > 1-basic-steps v 0 Search 1-basic-steps P
un
Organize v New folder 2R (2] ing Stream
@ OneDrive S MName Date modified Type Size m
e s mm This e 7 processOpt_default.cfg 11/2/201911:25PM  CFG File :::ig:fm
her_I ; erage_on_Concentration_
xR _J 3D Objects
hmr R
horn | [ Desktop
hurR_] Documents
::i_ ‘ Downloads
hurR ] D Music
hmy R
hmrR ] [&] Pictures
rurP_0 Videos G i t 1
puri o B Iveé a ndame to your new processing
hurR_P = WWindows (C:)
N SEVEACQUISITIC stream config file ’
hmrR_S - g ! >

s RECOVERY (E:)

All
s =¥ Network 2
dat.al File narge: | my_snmple_processnng/ vl
Save as EW v‘
UI NAM P
Band|
i Save ’ Cancel ‘
brecril 2 Hide Folders
Perf o
INPUT:
data - SNIRF data type containing data time course to filter, time
vector, and channels. d
hpf - high pass filter frecquency (Hz) an Save
Typical walue is 0 to 0.02Z2.
1lpf - low pass filter frecuency (Hz)
Typical wvalue is 0.5 to 3. w




.CFG file format

1 files loaded successfully

0 files failed to load aux1

[JFix Y-range

22

4 Homer3 (v1.14.1) - ci\jdubb\workspaces\subjects\fnirs-course\EXERCISES-CLEAN\EX1_Basic_data_analysis\1-basic-steps . a
File Tools View
Edit Stimulus
Edit Processing Stream
Plot Probe
Display P-Values
" To load and change the
0.8 - ° .
processing stream file, open
0.7 -
L3
ol ProcStreamEditGUI:
os| Tools => Edit Processing Stream
04
03[
0.2
0.1 1
0 | I 1 ] | | 1
50 100 150 200 250 300 350
Current Processing Element Motion Artifacts
simple_nirs_noStim. snirf Processing Level Calculate I Show Excluded Manual [] Exclude Time
5 . [] Show Excluded Auto
O Group Edit Options I Applyto all
[] Show Excluded by Chan
O Subj Plot Type Select Plot Window
Pan Left/Right
@® Run (® Raw Data 690 HRF < | > | Reset View
10D ! [JFix X-range
0 400
e () Conc [ Aux




CFG file format

[®] Homer3 (v1.14.2) fnirs-course\EXERCISES-CLEAN\EXT_Ba \1-basic-steps -
File Tools View
2F 1_ treamEditGUL: (1.14.2) - c\jdubbhworksp S-CLEANAEXT_Basi : c
File N
181 Run Subject Group
Registry Functions Usage Options Current Processing Stream
1.6
A A
hmrR_Blockivy Add
hurP_GLM
1.4 B hnrR_Intensity20D Delete ‘
humrR MotionArtifact
hurR_MotiondrtifactByCl
1.2 + hmrR_MotionCorrectChsi Up ‘
hmrR_MotionCorrectPCA v
hmrR MotionCorrectPCAr Down ‘
1k hmrR_MotionCorrectRLOE:
hurR MotionCorrectSplis
hurR MotionCorrectSpliy Load
| hurR MotionCorrectWave.
0.8 hurR_0DZConc Save ‘
50 hurR_0DZConc_new
hmrR PCAFilter
hmrR_PruneChannels v
. hurR_StimRejection
Current Processing Element v = acts
' i ' Exit | Clear All
simple_nirs_n < > xcluded Manual [ Exclude Time
dataZ = humrR_BandpassFilt{ data, hpf, 1lpf ) xcluded Auto
xcluded by Chan
UI NAME:
Bandpass_Filter "
DESCRIPTION: ft/Right
Perform a bandpass filter on time course data. =
v > | Reset View
INPUT:
data - SNIRF data type containing data time course to filter, time -range
wvector, and channels.
hpf - high pass filter frecquency (Hz) 10
Typical wvalue is 0 to 0.0Z.
lpf - low pass filter frequency (Hz) £
1 files loaded successfully r r qEmey hd fange
0 files failed to load 2




.CFG file format

\EXERCISES-CLEAN\EX1_Basic_data_analysis\1-basic-steps -
File Tools View
1r-
2
0.9 -
? ProcStreamEditGUL (1.14.1) - cyjdubbiworkspacesisubjectsifnirs-course\EXERCISES-CLEAN\ExXT_Basic_data_analysis - O
08 L {4 Pracess Options Config File to Load From? X o
07k N « Ex1_Basic_data_analysis > 1-basic-steps v O Search 1-basic-steps r
Organize v New folder v M @ ing Stream
~
0.6 - Install 2 Name Date modified Type Size
. fandpass_Filter
Snirf __'Jl my_simple_processing.cfg 11/2/201911:31 PM CFG File
0.5 @ OneDrive M_?] processOpt_default.cfg CFG File
[ This PC Date modr /2019 11:31 PM
04 -
8 3D Objects 1
I Desktop
0.3
Documents
0.2 & Downloads
: b Music
[&=] Pictures
011 B videos © 1
e Windows (C:)
0 1 Clear All L L 1 I I
- SAVEACQUISITIC
50
= RECOVERY (£) I
. v < >
Current Processing Element File name: | my_simple_processing.cfg v| l (*.cfg) v‘ otion Artifacts
I op Cancel ‘ Show Excluded Manual [] Exclude Time
S — - S—— S — ] Show Excluded Auto
INPUT: Show Excluded by Chan
data - SNIRF data type containing data time course to filter, time 2
vector, and channels. ot Window
hpf - high pass filter frequency {(Hz) .
Typical value is 0 to 0.02Z. Pan Left/Right
1lpf - low pass filter frequency (Hz) .
Typical value is 0.5 to 3. © < | > | Reset View
[JFix X-range
0 400
< ) Conc 0
~ Aux y
1 files loaded successfully LIFix Y-range
0 files failed to load auxl o




.CFG file format

— I
[#] Homer3 (v1.14.7) - cihyjdubblworkspaceshsubjectsifnirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysis\1-basic-steps - O
File Tools View
1 —
09 2
0.8 B ° °
2 — This will open the
e ProcS EditGUI, wh
4 ProcStreamOptionsGUI: (1.14.2) - cyjdubbworkspacesisubjectsifhirs-course\EXERCIS..,  — O X roc t re a m It 4 e re yo u
L3
can modify parameters of each
hmrR_Intensity20D f -
hmrR_BandpassFilt hpf 0.010 u nCtIon usage
Ipf 0.500
hmrR_0D2Conc ppf 1.01.0 i
hmrR_BlockAvy: Block_Average_on_Concentration_Data trange 2.0 20.0 F 1 1
| I | I . . \ . . \ \
200 250 300 350
Current Processing Element Motion Artifacts
simple nirs_n rf Processing Level 4|':alcula‘e Show Excluded Manual [] Exclude Time
O Group Edit Options [ Apply to all U RHpaERe
[] Show Excluded by Chan
(O Subj Plot Type Select Plot Window
- Pan }e Right )
© R ORowbate [ w 1 - Click on:‘Options’..
10D ! _| [JFix X-range
0400
v () Conc A .
1 files loaded successfully A s

0 files failed to load aux1 v 22




Let’s analyze some fNIRS data: HOMER3 Ul

When opening Homer3, you need to select:

* The dataset(s): a folder containing at least one .snirf (or .nirs) file. If all you have are .nirs
files, Homer3 will convert the files to the .snirf format.

* The data processing stream: a .cfg file. If you click ‘Cancel’, a default process stream will
load.

e Start Homer3
 When prompted to select a .nirs folder, navigate to and select folder
/Exercises/Ex1_Basic_data_analysis/

 When prompted to select a .cfg file, select my_simple_processing.cfg file we
just created.

Note: If you’re already in Homer3 and need to change the data directory or the .cfg file:
* Go to File > Change Directory, and select your nirs folder
* Go to Tools > Edit Processing Stream and click the Load button to select .cfg file




Homer3 MainGUI

4 Homer3 (v1.14.1) - cyjdubbiworkspacesisubjects\fnirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysis\1-basic-steps - O X
File Tools View k]
1
o.gl 2
0.88-
0.7§
N : Source /
v Data plot , detector
ol window geometry
0.3f window
0.28
014 S 1
’ % % L TEE
= = - Motion artifacts/correction
I odi roc stream options ion Arti
‘ s nirs r‘||’|!:i| -=:r|ir ~ P ing Level y p S p Opgqﬂﬂ;g:léng Mcal'9ar|‘tr|:|°EI;§|udg Time
- 0:5tim. s rocessing Leve nd run pro
Se ect Current p C%SGSroulurplg Edit Options ] Applyto all [] Show Excluded Auto
element: run, subject or group.

Subj Plot Type Select

Current element’s d%taJ will be

calculated and dispfaedinthe ] ™ o |1 o . < | > | resatview |
data plot windo oo [ Fix X-range
. e o D;@s,elect which part
IX Y-range

1 files loaded successfully
0 files failed to load aux1 )

What data type to display

~ 2, of the data plot
window to view




Displaying raw fNIRS data

4 Homer3 (v1.14.1) - ciyjdubbiworkspacesisubjects\fnirs-course\EXERCISES-CLEANEx1_Basic_data_analysis\1-basic-steps - O X
File Tools View k
1 —
0.9 - -2 ’
0.8 -
07 Click any optode in
06 the source/detector
o5k I geometry window to
0al view raw data time
o ' series for its
connected channels
021
01t L, )
0 1 1 1 Il 1 1 1 i
50 100 150 200 250 300 350
Current Processing Element Motion Artifacts
simple_nirs_noStim. snirf Processing Level ﬂl Show Excluded Manual [ Exclude Time
O Group Edit Options Applyto all WG] I L
[[] Show Excluded by Chan
(O Subj Plot Type Select Plot Window
Pan Left/Right
® Run (® Raw Data 690 HRF < | > | Reset View
10D ! - [JFix X-range
0400
: L L] Aux [JFix Y-range

1 files loaded successfully
0 files failed to load aux1 v 22




Displaying raw fNIRS data

T Homer3 (v1,14.1) - c\jdubbtworkspacesisubjects\fnirs-course\EXERCISES-CLEANNEXT_Basic_data_analysis\1-basic-steps — O A
File Tools View
26
r 2
2.4
2.2 r
2 -
1.8
1.6
14
1.2 - r
1 _
r 1 1
0.8 I I I I I I I L L L L L L L
50 100 150 200 250 300 350
Current Processing Element Motion Artifacts
e nirs n f Processing Level Calculate | Show Excluded Manual [ Exclude Time
O Group Edit Options [~] Apply to all e LS G D
[]1 Show Excluded by Chan
O Subj Plot Type Select Plot Window
Pan Left/Right
® Run (® Raw Data 690 HRF < | > | Reset View
1 v
10D [JFix X-range
0 400
v 1 Conc ] Aux )
1 files loaded successfully D Fix Y-range
0 files failed to load aux1 | 22 |




Displaying the raw fNIRS data

1 files loaded successfully
0 files failed to load

[ Au

‘aux1

v ‘

(4 Homer3 (¥1.14.1) - cAjdubbworkspaces\subjects\fnirs-course\EXERCISES-CLEAN\EXT_Basic_data_analysis\1-basic-steps - [m] X
File Tools View >
=
28 I
ek ' ha for. il ’
i LAY i s
1440, 448 AR ahak, AR A Wi, A bi, &
24 %v:""é""’e’ 3it WY it 1 WY %""&"{?s‘t&’;ﬁ"% A
L : ' B o £ £ 4 LT
g":{'é»f" ‘3, PTEETRA i
22t L LI i
2+ L
18
1.6 -
Anad s BN, MR ) AMRRARRTS L »
14755 . s asANy bt "."7‘-’-5" VTR T TN !'é*ég"‘fq“\"""?k'{t:ﬁ_ik
i EEE L .. [ ¥ Y
: b Y Ad i
12f AW i .
1 1 1 1 1 1 Il ]
50 100 150 200 250 300 350
Current Processing Element Motion Artifacts
simple nirs noStim.snirf Processing Level ﬂl Show Excluded Manual [] Exclude Time
O Group Edit Options [ Apply to all WL AR ST
[] Show Excluded by Chan
) Subj Plot Type Select Plot Window
Pan Left/Right
@® Run ® Raw Data %H HRF < | > | Reset View |
10D -_‘ v‘ []Fix X-range
[
. ~ Select wavelength to displa

[JFix Y-range

\J




Zooming in on data

4] Homer3 (w1.14.1) - c\jdubbhworkspacesisubjects\fnirs-course\EXERCISES-CLEANAEx1_Basic_data_analysis\1-basic-steps - O X
File Tools View
26
2
2.4
2.2
2 |-
'8 *Select data region to zoom
in on by dragging mouse in |
1.6 .
the data plot window.
1.4
1.2
r 1 1
a“
| | | | | | | Make sure ETcIude
0.8 : ; : ; : . ; : .o o
50 100 150 200 250 300 350 Time” option fis
Current Processing Element Motion Artifacts unc h ec ked
simple_nirs_naStim.snirf Processing Level ﬂl Show Excluded M I [JExclude Time
O Group Edit Options Apply to all WL L AT UL
[[] Show Excluded by Chan
() Subj Plot Type Select Plot Window
Pan Left/Right
® Run (®) Raw Data e HRF < | > | Reset View
10D ! - [JFix X-range
0 400
v 1 Conc A )
1 files loaded successfully - WAL
0 files failed to load aux1 v 22




ooming in

4 Homer3 (w1.14.1) - cihjdubbworkspacesisubjects\frirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysis\1-basic-steps - m]
File Tools View
23
225
22 I
215 I
21 i
2.05 {1 !
2r 3 1
I 1 | | | 1 | | | . A A A A
135 140 145 150 155 160 165 170 175 180
Current Processing Element Motion Artifacts
N 1 Processing Level Calculate | Show Excluded Manual [] Exclude Time
O Group Edit Options [ Apply to all BT G
[[] Show Excluded by Chan
(O Subj Plot Type Select Plot Window
Pan Left/Right
® Run (® Raw Data HRF < | > | Reset View
1
10D [] Fix X-range
0400 |
() Conc [ Aux )
1 files loaded successfully LIFix Y.range
0 files failed to load aux1 e




Modifying processing stream options

(4 Homer3 (v1.14.1) - ci\jdubbyworkspacesisubjectsifnirs-course\EXERCISES-CLEANExT_Basic_data_analysis\1-basic-steps — O X

File Tools View k

23f 2 - Set hpf (high-pass filter)
1 .
205} [« ProcStreamOptionsGUI: (1.14.2) - c:\jdubb\workspaces\subjects\fnirs—course\E)(ERCl‘Eua H d I:I pﬁ( ( IOW- pa SS fl Ite r) to
EXIT 8 H H
2l 0, i.e. no filtering
hmrR_Intensity20D
215
hmrR_BandpasskFilt hpf 0.000
21 Ipf 0.000
2.05
hmrR_0D2Conc ppf 6.0 6.0
2r 1
135 1 ;0 1 ;5 1;0 hmrR_BlockAvg: Block_Awverage_on_Concentration_Data trange 2.0 20.0
Current Processing Element Motion Artifacts
simple_nirs_noStim. snirf Proces Show Excluded Manual [] Exclude Time
O Group Edit Options Apply to all E z:uw :xc:u:e: :utzh
ow Excluded by Chan
O Subj Plot Type Select Plot Window
- 1 Pan Left/Right
@® Run 1 .Open pr@)ongnggl ng o) HRF < | > | Reset View
options by clicking 1 . S
. I, 0 ix X-range
Edit Options button a0
v

. . Conc A .
1 files loaded successfully in Ma | nG U I L] Aux [JFix Y-range

0 files failed to load aux > 22 |




Running the processing stream

4 Homer3 iv1.14.2) - ciydubbhworkspacesisubjectsitnirs-course\EXERCISES-CLEANYEX]_Basic_data_analysis\1-basic-steps - (]

File Tools View

26

24 r

22 r

181

n

[ ProcStreamOptionsGUI: (1,14,2) - ciyjdubbworkspaces)

~ chpfand lpfare st

hmrR_Intensity20D Set to 0 /_\ 14k

hmrR_BandpassFilt hpf 0.000
Ipf

1 1

hmrR_0D2Conc ppf

o w0 w0 a0 20 a0 30 Click Calculate button
Current Processing Element to ru n’"'pr'ec Stream

hmrR_BlockAvg: Block_Average_on_Concentration_Data trange — B —— Calculate Show Excluded M (INIERE e
rocessing Level
Show Excluded Auto
O Group Edit Options ] Apply to all U
[] Show Excluded by Chan
O Subj Plot Type Select Plot Window
Pan Left/Right

@® Run (® Raw Data 690 HRF < | > | Reset View I
1 v
10D Q [JFix X-range

(1 Conc [ Aux .
1 files loaded successfully [JFix Y-range

ALY iSSP T = g — 0 files failed to load auxi v .22

[FeRAT) -




Intensity to AOD

(4] Homer3 (w1.14.2) - c\jdubb\workspacesisubjects\firs-course\EXERCISES-CLEAN\ExT_Basic_data_analysis\1-basic-steps - m)
File Tools View
0.25
r 2
0.2
0.15 1 I
ERPNT N ill .
0.1 YV
0.05 ,'J »
| |
\ 1 i .
& ProcStreamOptionsGUI (1.14.2) - cjdubbiworkspaces\subjectsifnirs-course\BXE..  — O 0 M
L AU 1' ’|
EXIT 0.05 I y‘ " { ' ‘
hmrR_Intensity20D 0.1 |
hmrR_BandpassFilt hpf 0.000 -0.15 F
Iof r 1 1
P 0.000
_o 2 Il 1 1 1 1 | Il L L L n n n n
50 100 150 200 250 300 350
hmrR_0D2Conc ppf 6.06.0 -~ )
- Current Pr ing Element Motion Artifacts
simple_nirs_noStimsni | processingLevel __ Caloutate_ | (4 Show Excluded Manual [ Exclude Time
[] Show Excluded Auto
hmrR_BlockAvy: Block_Average_on_Concentration_Data  trange 2.0200 O Group Edit Options ] Applyto all (] Show Excluded by Ch
-0 204 ow Excluded by Chan
O Subj Plot Type Select Plot Window
Pan Left/Right
® Run (O Raw Data 630 HRF < | > Reset View I

GitBash g A S \1—",
" i i A : @® 0D [JFix X-range
- ' g 0400
() Conc

$ . . .
. ~ — 1 files loaded successfully g [JFix Y-range
ﬂ? USep Uk ":‘_ -—_ 0 files failed to load Sel ms:f 0 D




AOD to Hb concentrations

4 Homer3 (1.14.2) - ci\jdubblworkspaces\subjectsifnirs-course\EXERCISES-CLEANAEXT_Basic_data_analysis\1-basic-steps — [}

File Tools View

3_

: : ,’ | ,‘ T . |" “f.v, I
, : M " it l" ; ff | ",1 ! hr f .

& ProcStreamOptionsGUI: (1.14.2) - c\jdubbwarksp

EXIT -2

es\subjects\fnirs-cou

hmrR_Intensity20D

hmrR_BandpassFilt hpf 0.000 ro1 1
Ipf 0.000 4 I I | I I | I L L L L L L N

50 100 150 200 250 300 350
hmrR_0OD2Conc ppf 6.06.0 Current Processing Bement Motion Artifacts
Siple_rirs_noStim snil | ~| processingLovel N ] Show Excluded Manual [ Exclude Tim
—— [] Show Excluded Auto
hmrR_BlockAvy: Block Average_on_Ci jon_Data  trange 20200 O Group = [ Show Excluded by Chan
O Subj " Plot Type Select ~Plot
Pan Left/Right
@® Run ) Raw Data Hho HRF < | > | Reset View
1 v
O oD \—] [J Fix X-range
0 400
v
(@) Conc [ Aux
e - . 1 files loaded successfully ‘ LIFix Y-range
ma;ru}-; Wi e =50 .s._:: — 0 files failed to load aux1 22

Select Conc



AOD to Hb concentrations

1 files loaded successfully

4. Horner3 {v1.14.2) - c:\jdubb\workspaces\subjects\frirs-course\EXERCISES- CLEAN\EXT_Basic_data_analysis\1-basic-steps — [m]
File Tools View
251
|
2 i
I
(|
6 1)
L
putty  IDLE( e TS
3 1 !i'
10 ;’I T
kit
I ",
OpenOffice QT Design 0.5 .
@ ProcStreamOptionsGUI: (1.14.2) - c\jdubb\workspaces\subjects\frirs-course\EXERCIS.,  — O A !
|I "l
EXIT 0. .."
A
. 1‘1 '
(B 1]
hmrR_Intensity20D 0.5+ "
1
hmrR_BandpassFilt hpf 0.000 A+
Ipf 0.000 I 1
_1 5 1 1 1 L 1 1 1
50 100 150 200 250 300 350
hmrR_0OD2Conc ppf 6.06.0
Current Processing Element Motion Artifacts
[simple_nirs_noStim.snif A Processing Level ml Show Excluded Manual ] Exclude Time
hmrR_BlockAvg: Block_Average_on_Concentration_Data trange 2.0200 06 Edit Options el [] Show Excluded Auto
it roup
[[] Show Excluded by Chan
O Subj Plot Type Select Plot Window
Pan Left/Right
® Run O Raw Dat HRF < | > I Reset View
1 | .
O ol v [JFix X-range
N o (g Conc
Choose which ey

0 files failed to load

emoglobin ™

specie(s) to display



Band-pass filtering

E ProcStreamOptionsGUL (1.14.2) - ci\jdubblwaorkspacesisu

hmrR_Intensity20D

hmrR_BandpassFilt

hmrR_0D2Conc

hmrR_BlockAvy: Block_Average_on_Concentration_Data

4 Homerd (v1.14.2) - c'\jdubblworkspaces\subjects\nirs-course\EXERCISES-CLEAN\EXT_Basic_data_analysis\1-basic-steps - ]
File  Tools View
2.
2
151
1 -
05F : |
L o
hpf 0.00 | W \ m
| |
Ipf 0.0 'y LR
I
151
EXIT 1 1
_2 Il | | | Il | | | L | L L L L
145 150 155 160 165 170 175 180 185
hpf Current Processing Element Motion Artifacts
Ipf _ Procassing Level M [ Show Excluded Manual [ ] Exclude Time
Yo []Show Excluded Auto
Edit Options [/ Applyto all
O Group - e ] Show Excluded by Chan
ppf 6.06.0 0 Subj Plot Type Select Plot Window
Pan Left/Right
@® Run () Raw Data ! HRF < | > Reset View I
trange 20200 00D 1 v Fix X-range
: ©Conc O Aux Fix Y-ran
1 files loaded successfully fange
0 fles failed to load auxt v 22




Band-pass filtering

finterge M

WERPNT  putty IDL

z ProcStreamOptionsGUI: (1.14.2) - chjdubblworkspaces\

" hpf 0.00
hmiR_Intensit20D Ipf 0.5

hmrR_BandpassFilt hpf
Ipf
hmrR_0D2Conc ppf

a

0.500

6060

|

hmrR_BlockAvy: Block Average_on_Concentration_Data trange 20200

4 Homer (¥1.14.2) - ciyjdubbworkspacesisubjects\fnirs-course\EXERCISES- CLEAN\EX1_Basic_data_analysis\1-basic-steps - O
File Toals  View
e
2
151
1 -
05r
0k
051
-1
-15F
1 1
2 | | | | | | | | | , , . A , ,
145 150 155 160 165 170 175 180 185
Current Processing Element Mation Artifacts
_ PriResig Lol m} [ Show Excluded Manual [ ] Exclude Time
e Show Excluded Auto
Edit Options ~ [/] Applyto all 0
O Group [] Show Excluded by Chan
0 Subj Plot Type Select Plot Window
Pan Left/Right
® Run () Raw Data I HRF < | > Reset View
OoD \1—V/ [ Fix X-range
) 142 189
@ Conc [ Aux a
1 files loaded successfully Bl
0 fles failed to load auxt v 22




d-pass filtering

4 Homer3 (¥1.14.2) - ciyjdubbhworkspaces\subjects\fnirs-course\EXERCISES-CLEAN\Ex_Basic_data_analysis\1-basic-steps - O
File  Tools  View
ar
roo2
2 -
‘ |
i 10 I I
’ | 0 ||
L i
irefox l I | | f '
415 0H | 1 | ‘ | L
M ’ ’ | l l ” |
m > R | | | /
(4 ProcStreamOptionsGLL (114.2) - cyjdubbhworkspaceshsubjects\fnirs-course\EXERCIS.,  — O 1k " ' ! ‘ ' l ’ I
J
EXIT
hmrR_Intensity20D £2
ro1 1
hmrR_BandpassFilt hpf 0.000
-3 Il Il Il | | | | L L ! L L L i
Ipf
’ | 050 | 50 100 150 200 250 300 350
Current Processing Element Motion Artifacts
Calculate I
hmrR_0D2Conc ppf 6.06.0 PR oSmERA T ~|  procossingLevel alcufa [ Show Excluded Manual [ Exclude Time
O Group Edit Options [ Apalyto al [[] Show Excluded Auto
[ Show Excluded by Chan
hmrR_BlockAvy: Block_Average_on_Concentration_Data trange 20200
:’ (O Subj Plot Type Select Plot Window
Pan Left/Right
® Run () Raw Data HRF < > | Reset View
QoD _1 ’ [JFix X-range
142 189
v
@® Conc [ Aux .
1 files loaded successfully C1Fix Y-range
0 files failed to load aux1 v 22

Reset data plot
view



Band-pass filtering

hpf 0.01
Ipf 0.5

z ProcStreamOptionsGUI (1.14.2) - c\jdubbhworkspace

s\subjects\firs-course\EXERCIS...  —

O

EXIT

hmrR_Intensity20D

hmrR_BandpassFilt

hmrR_OD2Conc

hmrR_BlockAvy: Block_Average_on_Concentration_Data

hpf
Ipf

ppf 6.06.0

trange 20200

4 Homer3 (v1.14.2) - c?\jdubbworkspaces\subjects\fnirs-course\EXERCISES- CLEANNExT_Basic_data_analysis\1-basic-steps - O
File Tools View
2r
roo2
1.5
! |
10 l | r
|
0.5 l A Iy |
| \ I '
0 | J ! ¥ | .‘
| [ ' } | ‘ il L
051 | | d v
1 4 ‘
1 H [ f :
|
5 :
2+
r1 1
_2 5 | | | | | | L L ! ! ! !
50 100 150 250 300 350
~Current Processing Element | Motion Artifacts
Calculate )
Isimple_nirs_noStimsnif A processing Level Show Excluded Manual [ Exclude Time
O Group Edit Options  [] Applyto all [ Show Excluded Auto
[[] Show Excluded by Chan
O Subj Plot Type Select  Plot Window
Pan Left/Right
® Run (O Raw Data HRF < | > | Reset View
QOop \—‘w ’ [JFix X-range
142 189
v
@© Conc [ Aux ;
[JFix Y-range
1 files loaded successfully
0 files failed to load




Band-pass filtering

4 Homer3 (41.14.2) - cyjdubbiworkspaces\subjects\fnirs-course\EXERCISES-CLEAN\EX1_Basic_data_analysis\1-basic-steps - O
File  Tools View
151
2
1 H
0.5
hpf 0.10 0
[ ]
p . -05 1
4 ProcStreamOptionsGLUL (114.2) - c\jdubbworkspaces\subjects\fnirs-course\EXERCIS..  — O
A
EXIT
1 1
hmrR_Intensity20D
A .1.5 | | | | | | | L L L ! ! L L
hmrR_BandpassFilt hpf 0.100 50 100 150 200 250 300 350
Ipf 0.500 >
Current Processing Element  Motion Artifacts
il _is_naStm S A pracessing Love [ coeise| (2 Show Excluded Manual [ Excud Time
hmrR_0D2Conc ppf 6.0 6.0 [] Show Excluded Auto
O Group | Edit Options  [/] Applyto all
[[]Show Excluded by Chan
hmrR_BlockAvy: Block_Average_on_Concentration_Data trange 2.020.0 O Subj Plot Type Select  Plot Window
Pan Left/Right
® Run () Raw Data < | > I Reset View |

HRF
-
Oop []Fix X-range
142 189
v

@ Conc (] Aux .
1 files loaded successfully [JFix Y-range

0 files failed to load aux1 v 22




This dataset doesn’t have stimulus onsets, so we will enter them manually

Thurbs.db

4 Homer3 (w1,14.2) - C\jdubbhwarkspacesisubjects\frirs-course\EXERCISES-CLEANAEX_Basic_data_analysis\1-basic-steps - C
File  Tools View
Edit Stimulus ° °
== Open StimEditGUI
Plot Probe
under the Tools menu f
brduing Mo 5
|
od
|
-5 M
EXIT
niR_Intensity20D -10
nrR_BandpassFilt hpf 0.010
Ipf 0.500 ro1 1
15 I I | | | | | L " . . . L "
wrR_0D2Conc ool 3010 50 100 150 200 250 300 350
i Motion Artifact:
nrR_BlockAvy: Block_Average_on_Concentration_Data trange 2.020.0 e Calculate on Artfacts
simple_nirs_noStim. snirf Processing Level Show Excluded Manual [J Exclude Tim
— [[] Show Excluded Auto
O Group Edit Options Applyto all
[[] Show Excluded by Chan
(O Subj Plot Type Select Plot Window
Pan Left/Right
© Run O Raw Data UL by < | > Reset View
1 v
C oD [JFix X-range
0 400
z © Conc Aux .
1 files loaded successfully LIFix Y-range

0 files failed to load

aux1 22




StimEditGUI

NOTE: Any edits to stims you make in
StimEditGUI will automatically update
the data plot window in MainGUI

z StimEditGUIL {1.14.2) - cyjdubblworkspaceshsubjectshfnirs-course\EXERCISES-CLEANNExT_Basic_data_analysish1-basic-steps — O X

simple_nirs_noStim.snirf :

j ’Rename condition

= "

Time | Duration | Value

1 21.9997 5 1

1 1 1 1 1 1 1

50 100 250 300 350

150 200
B “"“’E"'"S"’"“@N You can add one or multiple
stimulus marks using this edit
window < 3




StimEditGUI

z StimEditGUL (1.14.2) - etyjdubblworkspacesisubjectshfnirs-course\EXERCISES-CLEANNEx1_Basic_data_analysis\1-basic-steps — O

simple_nirs_noStim.snirf :

j ‘Rename condition

=1

Time ‘ Duration ‘ Value

4 MENU - m| X

Add stim mark at t=22.0...

1

h 2 — Select Condition 1

New condition

Cancel

1 1

50 100

EXIT Add / Edit Stims :  22:25:347

e

1 - Add stim marks time points
every 25 seconds starting at t = 22s >
(Type: 22:25:347)




StimEditGUI

z StimEditGUL: (1.14.2) - cyjdubbworkspacesisubjectsifnirs-course\EXERCISES-CLEANAEx1_Basic_data_analysish1-basic-steps — O X

simple_nirs_noStim.snirf :

,:Iﬂ ’1 v‘ ’Rename condition‘
Time ‘ Duration | Value
1 |21.9997 5 1
2 |47.0396 5 1
3 [71.9996 5 1
4 (97.0395 5 1
5 (1220394 5 1
6 (1470394 5 1
7 (1720393 45 1
g (1969993 5 1
0 (2220392 45 1
10 (2470391 5 1
11 (2719991 5 1
12 [297.0390 5 1
13 (3219990 5 1
14 (3469989 5 1
1 | | | 1 1 1

50 100 150 200 250 300 350

EXIT Add / Edit Stims :  22:25:347




StimEditGUI: Multiple conditions

z StimEditGUL (1.14.2) - cyjdubbhworkspacesisubjects\fnirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysish1-basic-steps — Od

simple_nirs_noStim.snirf :

v‘ ’Rename condition

=1

You can create multiple conditions Lol

4 MENU - m| X

Add stim mark at t=22.0...

1

New condition h either when you create

Cancel the stim mark ...
50 100 b

EXIT Add / Edit Stims : | 22:25:347




StimEditGUI: Multiple conditions

... or by modifying
existing stim marks

(4 StimEditGUL: (1,14.2) - chyjdubbiworkspaceshsubjectshfnirs-course\EXERCISES- CLEAN\Ex1_Basic_data_analysish1-basic-steps - O X

simple_nirs_noStim.snirf :

I:Iﬂ ’1 v‘ ’Rename condition‘
Time { Duration l Value
1 [21.9997 5 1
2 47.0396 5 1
3 |[71.9996 5 1
~ 4 970395 5 1
. 5 [122.0394 5 1
1-To modlfy 6 147.0394 5 1
el . ! 7 1720393 5 1
existing stim, drag 5 199993 5 :
. 9 (2220392 5 1
mouse around it. 10 2470391 5 1
11 2719991 5 1
12 [297.0390 5 1
13 321.9990 5 1
12 346.9989 5 1
1 1 1 1 1 1 1

50 100 150 200 250 300 350

EXIT Add / Edit Stims :  22:25:347




StimEditGUI: Multiple conditions

A StimEditGUE (1.14.2) -

chyjdubbyworkspacesisubjects\frirs-course\EXERCISES-CLEANYExT_Basic_data_analysis\1-basic-steps

simple_nirs_noStim.snirf :

50

EXIT

100

(4] MENU

Edit'Delete stim markis) at t=47.047.0 to...

New condition

Yoy

Togyle active on/off

Delete

Cancel

v‘ ’Rename condition ‘

T
—

2 — Select

‘New -conditi?

350

Add / Edit Stims : 22:25:347

Time

I Duration |

Value

|

21.9997

47.0396

71.9996

97.0395

122.0394

147.0394

R B R L I S W L

172.0393
196.9993
222.0392

ﬁﬁ.nam

271.99:M

12

297.0390

13

321.9990

14

346.9989

5
5
5
5
5
5
5
5
5
5
5
5
5
5

e R N T B T T T I T N S S S Y




StimEditGUI: Multiple conditions

E StimEditGUL (1.14.2) - cyjdubblworkspacesisubjectsifnirs-course\EXERCISES-CLEANAExT_Basic_data_analysish1-basic-steps

simple_nirs_noStim.snirf :

v‘ ’Rename condition‘

=1l

Time | Duration | Yalue
1 219997 5 1
2 470396 5 1
PN - X 7 71999 5 1
o 4 970395 5 1
5 1220394 5 1
’2 \ 6 147.0394 5 1
[ ok || cancel| 7 1720303 5 1
5 1969993 5 1
9 2220392 5 1
3 — Enter a new 10 2470391 5 1
L. 11 2719991 5 1
CDnd|t|01 name 12 2970390 5 1
13 [321.9990 5 1
14 (3469989 5 1
] 1 1 ] ] 1 1
50 100 150 200 250 300 350
EXIT Add / Edit Stims :
< >




StimEditGUI: Multiple conditions

—

| StirmEditGUL (1.14.2) - cyjdubbhworkspaceshsubjects\frirs-course\EXERCISES-CLEAMNYExT_Basic_data_analysis\1-basic-steps — O

simple_nirs_noStim.snirf :

1 v ‘Rename condition
Time l Duration l Value
1 121.9997 5 1
2 |71.9996 5 1
\ 4 — We now have 3 [97.0395 5 1
.. o 4 |122.0394 5 1
two conditions 5 147.0394 5 1
& 1720393 5 1
7 1969993 5 1
g 2220392 5 1
o 2470391 5 1
10 (2719991 5 1
11 [297.0390 5 1
12 (3219990 5 1
13 [346.9989 5 1
| | | 1 1 1 |
50 100 150 200 250 300 350

EXIT Add / Edit Stims :  22:25:347




Stimulus onsets

|4 Homer3 (v1.14.2) - oty dubbhwarkspacesisubjectshfnirs-course\EXERCISES-CLEANAE:T_Basic_data_analysish1-basic-steps - L

File Tools View

2_

151

1_

0.5

(@) ProcStreamOptionsGUI: (1.14.2) - cijdubbhworkspacesisubjects\fnirs-course\EXERCIS.,  — O 15K

Back in MainGUI, the stim marks have
i heen updated. (NOTE what’s not” )

T - 2 ® jfcluded: we undid the newly created

Current Processing Element

hmrR_0D2Conc pf | 6060 | simple_rirs_noStim.snid 'Procesggen d it i O n Z b EfO‘r‘E‘EC re ati n g t hlig]omltid @-)I [ Exclude Time

[} Show Excluded Auto

O Group | EditOptions [/ Applyto all
[[] Show Excluded by Chan

hmrR_BlockAvy: Block_Average_on_Concentration_Data trange -2.020.0

O Subj Plot Type Select Plot Window
Pan Left/Right

® Run (O Raw Data M LIHRF < > I Reset View
[]Fix X-range

® Conc (] Aux
1 files loaded successfully [IFix Y-range

0 files failed to load aux1 v 22

Oop




Stimulus onsets: rejecting stim marks

To reject stim go back
to StimEditGUI

4 StimEditGUI: (1.14.2) - chyjdubbtworkspacesisubjectsifnirs-course\EXERCISES-CLEANAEx1_Basic_data_analysish1-basic-steps - O X

simple_nirs_noStim.snirf :

‘:l:l ’1 v‘ ’Renamecundition
1
. Time ‘ Duration ‘ Value
h Drag mo sejro nd the 19997 5 :
' . . 2 47.039% 5 1
stim mark you wish to e :
to ed 4 970395 5 1
5 1220394 5 1
6 147.0394 5 1
7 1720393 5 1
3 [196.9993 5 1
9 2220392 5 1
10 2470391 5 1
11 2719991 5 1
12 297.0390 5 1
13 3219990 5 1
1 1 L L L 1 L 14 3469989 5 1
50 100 150 200 250 300 350
EXIT Add /Edit Stims:
< >




Stimulus onsets: rejecting stim marks

[®] Homer3 (v1,14.2) - cyjdubbiworkspacesisubjectshfrirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysis\1-basic-steps - O

File Tools View k

=

U] T T 111 T I

? StimEditGUL (1.14.2) - c\jdubblworkspaceshsubjectsifnirs-course\EXERCISES-CLEAN\ExT_Basic_data_analysis\1-basic-steps - m}

I

simple_nirs_noStim.snirf :

4] MENU - m] X

-

v‘ lRanams condition ‘

Edit/Delete stim mark(s) at t=72.0-72.0 to... 1 Time ‘ Duration l Value ‘

21.9997
47.0396
71.9996
97.0395
122.0394
147.0394
172.0393
196.9993
222.0392
10 [247.0391

11 [271.9991
’ Delete 12 |297.0390

Current Processing Element 13 [321.9990
14 [346.9989

’ New condition

-2.5 I I ‘ Toggle active on/off
50 100

[LINT BN BT BT T BT RS T BT T T T
N N U (A G G G G (Y

e Time

simple_nirs im.s ’ Cancel
1 1

50 100 350

EXIT Add / Edit Stims : 22:25:347

- @® Conc 07

1 files loaded successfully [JFix Y-range

0 files failed to load aux1 -




Stimulus onsets: rejecting stim marks

Updates stim in MainGUI

automatically
2
15

1

0.5

_EAN\Ex1_Basic_data_analysish1-basic-steps — L
‘ ‘ ‘ | 2
(4 StimEditGUL: (1.14.2) - chjdubbyworkspacesisubjects\fnirs-course\EXERCISES-CLEANNEx1_Basic_data_analysis\1-basic-steps - [m] X

Current Processing Element

simple_nirs_noStim.snif A

simple_nirs_noStim.snirf :

dotted|line (toggled

tim mark now appears as

=3

v‘ Rename condition

Time

] Duration l

Value

21.9997

47.0396

71.9996

97.0395

122.0394
147.0394
172.0393
196.9993
222.0392
247.0391
271.9991
297.0390
321.9990
346.9989

off)

’ EXIT

100

150 200 250 300

Add / Edit Stims :

Rl R

350

Gh G G GGG L Oh

1
1
-1

[ECNR N (R (U P G G N Gy

1 files loaded successfully
0 files failed to load

@® Conc (] Aux

[JFix Y-range

’aux1

5 | =




Stimulus onsets: rejecting stim marks

h&t Homer3 (v1.14.2) - cihyjdubbhworkspacesisubjects\firs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysish1-basic-steps — O
File Tools View
2
1.5
1 -
0.5
0
1
-0.5 1
1
1
-1 1 1
1 1
5F : |
1 1
1 1
21 1 1 1
1 1
25 L1 '
50 Let’s saﬂy we:want to remove
Current Processing lemer these two stimulus onsets,,.... | Mot Aracts
Processing Level e e Show Excluded Manual [ Exclude Time
frorm the block-average | ciciios g [] Show Excluded Auto
[[] Show Excluded by Chan
() Subj Plot Type Select Plot Window
Pan Left/Right
® Run () Raw Data [THRF < | > | Reset View
oD M [ ! []Fix X-range
v
(® Conc A X
1 files loaded successfully L CIFix Y-range
0 files failed to load \a.m 22




Calculating and displaying the HRF

&

Emacs Spyder

4 Homer3 (v1.14.2) - ci\jdubb\workspaces\subjects\fnirs-course\EXERCISES-CLEAN\EXT_Basic_data_analysis\1-basic-steps - ]

File Tools View

4| ProcStreamOptionsGUI: (1,14.2) - cyjdubbhworkspaces\subjects\fnirs-course\EXERCIS..,  —

EXIT

hmrR_Intensity20D

hmrR_BandpassFilt

hmrR_0D2Conc

hmrR_BlockAvy: Block_Average_on_Concentration_Data

hpf
Ipf

ppf

trange -2.020.0

04r
2
0.3
0.2
0.1
0
-0.1
-0.2
2 — Calculate
-0.3 .
processing stream—
_0.4 | Il 1 Il 1 Il | Il 1 Il s ! !
0.010 0 2 4 6 ) 10 12 14 20 for current
0.500
- Current Processing Element Caleal ‘e ’ p roceﬁ,ﬁ,’ m,g e I e m e nt o
@ [simple_nirs_noStim.snif A Processing Level =L [/ Show Excluded Manual [ Exclude Time
O Graup IW 1 Anniyto all [J Show Excluded Auto
[] Show Excluded by Chan
O Subj Plot Type Select Plot Window
Pan Left/Right
® Run 1 Sele (3 Raw Daﬁ :ER Al MHRE < | | Reset View |
[@F] HhT v [JFix X- [JFix X-range
142189 |
. @® Conc
1 files loaded successfully [ Aux 2 ShQWraHRF
0 files failed to load D ‘ ‘ 22




Displaying the HRF

4 Homer3 (v1,14.2) - cijdubbwarkspacestsubjects\fnirs- course\EXERCISES- CLEANNEx]_Basic_data_analysis\1-basic-steps - O
File  Tools View
04r
ro2
0.3
0.2
0.1 I
0 L
-0.1 L
E ProcStres \jdubbworkspa sbjects\fnirs-course\EXERCIS.,  — -0.2 L
EXIT
-0.3
imrR_Intensity20D ! !
04 | I ] | I I I | I | J " " . " " . .
imrR_BandpassFilt hpf 0.010 0 2 4 6 8 10 12 14 16 18 20
Ipf 0.500
~Current Processing Element —  Motion Artifacts
imrR_0D2Conc ppf 6060 | Processing Level [ G| Show Excluded Manual — [7] Exclude Time
O Group Edit Options [ Applyto all [ Show Excluded Auto
[[]Show Excluded by Chan
imrR_BlockAvy: Block_Average_on_Concentration_Data trange -2.020.0
O Subj Plot Type Select Plot Window
Pan Left/Right
@® Run O Raw Dat; :::g [ HRF < | > | Reset View I

Display both T O

@) Conc Y .
jizsse=  HbO and HbR -




Display options: waterfall

TO-DO, coming soon: Waterfall display of channels as shown
below




Visualize all HRFs: the Plot Probe feature

Z Hormer3 (v1.14.2) - c\jdubbyworkspaceshsubjectsifnirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysis\1-basic-steps - O X

File = Tools View k]

Edit Stimulus

Edit Processing Stream
Plot Probe 2
Display P-Values

r 1 1
-0 4 1 1 1 1 1 1 | | 1 1 | i i n i i n L
0 2 4 6 8 10 12 14 16 18 20
Current Processing Element Motion Artifacts
Calculate | X
simple_nirs_noStim.snif A processing Level Show Excluded Manual [ Exclude Time
O Group I Edit Options [ Apply to all L] Show Excluded Auto
[[] Show Excluded by Chan
() Subj Plot Type Select Plot Window
Pan Left/Right
@® Run () Raw Data HRF < | > | Reset View
O oD ’ ! V} (] Fix X-range
142 189
< @® Conc [ Aux

1 files loaded successfully [Fix Y-range

0 filles failed to load aux1 v




Visualize all HRFs: the Plot Probe feature

——

— — | [ PlatPrabeGUL (1.14.2) - cijdubbiwork spacesisubjects\fhirs-course\EXERCISES-CLEAMN\ExT_Basic_data_analysis\... —
4| Homer3 ({ B B B

O

File Tools | °

0.4 r
03
D2

0.2 |

0.1

T

(=]
SN

S1 D1

Control Panel
-0.4
—‘ Scaling Time Marks

S Interval: | 5
1.0 1.0 n
Currenti O x O | Amplitude : | 0 | (micro-molars)

’ Duplicate Plot

(O Show Hidden Meas

(O Show Time Markers ‘ EXIT
(O Subj Plot Type Select
® Run () Raw Data
oD
e @ Conc

1 files loaded successfully
0 files failed to load

[ HRF
-1

[ Aux

’aux1

Motion Artifacts
Show Excluded Manual [ Exclude Time
[] Show Excluded Auto
[[] Show Excluded by Chan
Plot Window
Pan Left/Right

< | > | Reset View

[]Fix X-range
142189

[]Fix Y-range
22




Visualize all HRFs: the Plot Probe feature

T
& Homer3 4 PlotProbeGUI: (1.14.2) - cyjdubb'workspaceshsubjects\fnirs-course\EXERCISES- CLEAN\Ex1_Basic_data_analysish., - O X B O
File Tools | * ~
04r
B 2
0.3
D2 r
0.2
0.1 |
0 I
1 S1 D1
-0.1 L
0.2 i
0.3
r 1 1
Control Panel
_0.4 | L L L " " n L
Scaling Time Marks
Duplicate Plot
I Interval
Current 10 1.0 Amplitude (micro-molars) O Show Hidden Meas Motion Artifacts
- . e + : [ Show Excluded Manual [ ]Exclude Time
EXIT " [] Show Excluded Auto
[[] Show Excluded by Chan
(O Subj Plot Type Select Plot Window
Pan Left/Right
(® Run () Raw Data HRF < | > I Reset View
-1 v
O oD []Fix X-range
142189
v
@® Conc [ Aux .
1 files loaded successfully LIFix Y-range

0 files failed to load aux1 v 22




Group average: file names

Any directory that contains one or more files with the .nirs extension is considered by
Homer3 to be a group, organized into sub-groups called sessions (or subjects).

SubjectNamel_runO1.nirs
SubjectNamel_run02.nirs

SubjectNamel_runnl.nirs

SubjectName2_run01.nirs
SubjectName2_run02.nirs

SubjectNamem_run01.nirs
SubjectNamem_run02.nirs

You can compute the HRF:

—

—p

— —

SubjectNamem_runnm.nirs _

e attherun level

e at the session (or subject) level

e atthe group level

Data processed in Homer3 is saved automatically to disk:

* Run datais saved in the corresponding .nirs file

* Subject and group processing results are saved to
groupResults.mat

To go back to the state before any processing was done to the
dataset, go to File > Reset File



Group average: example

File > Change directory to Exercises / Ex1_Basic_data_analysis / 2-group-averaging

4 Homer3 (v1.14.2) - cyjdubbiworkspacesisubjectsifnirs-course\EXERCISES-CLEANEx1_Basic_data_analysis\1-basic-steps - O
| (4 Pick the new directary X "
&« v P <« fnirs-course > EXERCISES-CLEAM » Ex1_Basic_data_analysis » v O Search Ex1_Basic_data_analysis @
Organize v New folder Bz - o | 2
g fNIRS.workshop A MNarne Date modified Type Size
ProcStream @ 1-basic-steps 11/3/2019638AM  File folder
Snirf % 2-group-averaging 11/4/20196:32 AM  File folder
@ OneDrive i
3 This PC
) 3D Objects i
I Desktop
“| Documents
‘ Downloads I
D Music
&= Pictures r
B videos
e Windows (C1) | 1 1
- SAVEACQUISITIC
s RECOWERY (E:)
e w7
| Motion Artifacts
t Folder Cancel ‘ Show Excluded M I L] Exclude Time
oplyto al [] Show Excluded Auto
T Group e ]
[]1 Show Excluded by Chan
(O Subj Plot Type Select Plot Window
Pan Left/Right
@® Run @® Raw Data 690 LIHRF < | > | Reset View
-1 v‘ )
O 0D []Fix X-range
0 400
v
: () Conc [] Aux

1 files loaded successfully [JFix Y-range

0 files failed to load auxi v




Group average: example

File > Load Process Options (*.cfg)

B Load Process Options File

1t « Ex1_Basic_data_analysis > 2-group-averaging
Organize ~ New folder
Name
5 Quick access
m Desktop * SubjA
SubjB
4 Downloads
SubjC
Documents SubjD
¥ syncplicity Fo # SubjE

2-group-averagi
David

o bpt
Temp

& Dropbox (Partners

&2 fNIRS-course-20 o

D basic_process_noMA.cfg

<

X
v O  Search 2-group-averaging P
= m @

~

Date modified Type

10/29/2017 4:19 PM File folder
10/29/2017 4:20 PM File folder
10/29/2017 4:20 PM File folder
10/29/2017 4:20 PM File folder
10/29/2017 4:20 PM File folder
10/29/2017 10:43 AM  CFG File

Choose your processing stream *.cfg

File name: |basic_process_noMA.cfg

(*cfg) v

‘ Open Cancel ‘




average:. example

4 Homer3 (v1.14.2) - C\jdubb\workspaceshsubjects\fnirs-course\EXERCISES-CLEAN\EXT_Basic_data_analysis\2-group-averaging - m]

File Tools View

14 10 [‘j -
WNWMWWWMW‘“ 3 4

12 I
EXIT 10 r 13 16
W W, T ,.Mw;m b S AL LA, P Y
hmiR_Intensity20D WV“ i "/ 4
1 3 5 7 1"
hmrR_BandpassFilt hpf 0.000 I
Ipf 0.500 8+ 17 19 21 23 25 27
1 3 5 7 1
hmrR_0D2Conc_new ppf 6.0 6.0
6l
hmrR_BlockAvy: Block_Average_on_Concentration_Data trange 2.020.0 Wr“\v\" " """"'"WM I ) 4 6 8 10 12
4+ 18 20 22 24 26 28
I 2 4 6 8 10 12
Il Il Il " s L L L J
150 200 250 300 350
Motion Artifacts
-génuuh;}:veragmg LT Calculate Show Excluded Manual [ Exclude Time
subjA_run01.snirf - - [] Show Excluded Auto
subjA_run02.snirf O Group Edit Options Apply to all
subjA_run03. snirf [] Show Excluded by Chan
SubjB
SUEJ g_rungé» Sm: O Subj Plot Type Select Plot Window
SUEJ“CJ runoe sl Pan Left/Right
subjC_run01.snirf ® Run (@) Raw Data 690 HRE < > Reset View
subjC_run02.snirf
SubjD . | v
subjD_run01.snirf oD [J Fix X-range
SubjE
subjE_run01.snirf 0400
subjE_run02.snirf
" N g Fo I d e r cone LI [JFix Y-range
0 aux1 v 22

structure



Group average: example

EXIT
hmrR_Intensity20D

hmrR_BandpassFilt

hmrR_0D2Conc_new

hmrR_BlockAvy: Block_Average_on_Concentration_Data

hpf
Ipf

ppf

trange

0.000
0.500

6.06.0

2.020.0

4 Homer3 (v1.14.2) - C\jdubblworkspaces\subjects\fnirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysis\2-group-averaging

You can run the analysis at
the run level, session level,
or group level

Tools  View
4
x 10
14 -
M 13 14 14 15 15
M MWWW 29 30 31
12 W Y L
10 r 13 16
1 3 5 7 1
8+ 17 19 21 23 25 27
L 3 5 7 1
6 -
W""‘"ﬁ, MWWMWMWWMM P2 4 6 8 10 12
4+ 18 20 22 24 26 28
I 4 6 8 10 12
2 1 1 1 Il 1 L L L L
50 100 150 200 250 300 350
Current Processing Element Motion Artifacts
z—géouub;};fveraglng ~ [ el Calculate Show Excluded Manual [ Exclude Time
subjA_run01.snirf [ Show Excluded Auto
subjA_run02. snirf Edit Options  [] Applyto all
subjA_run03.snirf [] Show Excluded by Chan
SubjB
SUEJEJUHS;-SMZ Plot Type Select Plot Window
subjB_run02.sni .
SthCJ - Pan Left/Right
subjC_run01.snirf Raw Data 690 HRF X
subjC_run02.snirf ® < > bl
SubjD -1
subjO_run01.snirf oD [JFix X-range
SubjE
subjE_run01.snirf 0400
v Conc ] Aux
10 files loaded successfully L1Fix Y-range
0 files failed to load auxi 22



Run average: example

4 Homer3 (v1.14.2) - C\jdubblworkspaces\subjects\fnirs-course\EXERCISES-CLEANNEX1_Basic_data_analysis\2-group-averaging - O

File Toaols View

05
13 14 14 15 15
0.4 29 30 AN
<
EXIT 0.3 13 16
hmrR_Intensity20D
0.2 1 3 5 4 1
hmrR_BandpassFilt hpf 0.000
Ipf 0.500 17 19 21 2\/5 27
0.1
1 3 5 7 11
hmrR_0D2Conc_new ppf 6.06.0
0
hmrR_BlockAvy: Block_Average_on_Concentration_Data trange 20200 2 4 6 8 10 12
18 20 A . 24 6 28
01 2 — Run processing ‘stréam
for current processing
0.2 I | ! ! ! ! ! I | | . { H 2
Ty d e 5w w uw w s element: run‘SubjA_run01
Current Processing Element Motion Artifacts
z-géﬂulg}:veraglng ~ R T Calculate [/ Show Excluded Manual [ Exclude Time

subjA_runD1.snirf
subjA_run02.snirf
subjA_run03.snirf
SubjB
subjB_run01.snirf
subjB_run02.snirf
SubjC
subjC_run01.snirf
subjC_run02.snirf

[] Show Excluded Auto
O Group Edit Options Applyto all
[]Show Excluded by Chan

() Subj Plot Type Select Plot Window

Pan Left/Right
® Run O Raw Data " HRE < | > | Reset View |
HbT
v

SubjD -1
S0 i Oon 3 — Checkbox to show
ubj
subjE_run01.snirf 0400
subjE_run0D2.snirf @ Cone [ Aux H RF )
10 files loaded successfully i Yrange
0 files failed to load 1 —Select run auxt v 22

processing: 2 way to



average:. example

File

EXIT
hmrS_RunAvg: Run_Average_on_Concentration_Data

hmrS_RunAvgStd2: Run_Average_Standard_Deviation_on_Concentration_Data

Subject level
processing stream

Tools  View

05

4 Homer3 (v1.14.2) - Cjdubb\workspaces\subjects\fnirs-course\EXERCISES-CLEAN\EX]_Basic_data_analysis\2-group-averaging

29 30 A

1 1
23\ 25 27
7 \ 1

2 —Calculate ¢ © =
processing stream for
current processing *

_1 | | | | | | | | | 'l i L = L 3o |
0 2 6 8 10 12 14 16 18 element: subject
{ *N?
SubjA
Current Processing Element Motion Artifacts
‘z-géoui;}:veragmg Show Excluded Manual [ Exclude Time

subjA_run01.snirf [[] Show Excluded Auto
subjA_run02. snirf O Group Edit Options Apply to all
subjA_run03. snirf [[] Show Excluded by Chan

SubjB
sugjg_rung;.sn@: ® Subj Plot Type Select Plot Window
S runlZ. sni .

SubjCJ - Pan Left/Right
subjC_run01.snirf R Raw Dat HhO a HRF :
subjC_run02.snirf @ e HbR < > fosatviesy

SubjD . HbT - v

o 1 s 1 - Select subject . IR krange
ubj
subjE_runD1.snirf . 0400

| cu 2 n - processing. Two ways -
101 [JFix Y-range

iles loaded successfully .

0 files failed to load todoit. auxi 22



roup average: example

4 Homer3 (v1.14.2) - Ciydubblworkspaces\subjectsitnirs-course\EXERCISES-CLEANAEXT_Basic_data_analysis\Z-group-averaging - u

File  Tools View

05
13 14 14 15 15
04 29 30 3
03
13 16
0.2
1 3 5 A 1"
0.1 17 19 pil 23 25 27
i 1 3 5 11
0 2 — Calculat
wnrG_SubjAvy: Subj_Average_on_Concentration_Data tRange 5.010.0

thresh 5.0

processing stream for
current processmg
eIement group 2

0 2 4 6 8 10 12 14 16 18 group'averaglng

wnrG_SubjAvgStd: Subj_Average_Standard_Deviation_on_Concentration_Data

Current Processing Element Motion Artifacts

2-group-averaging Leltelbiin Show Excluded Manual [ Exclude Tim
SubjA
G rou p |EVE| subjA_run01.snirf — [ Show Excluded Auto
subjA_run012.snirf (® Group Edit Options Applyta all
i A Show Excluded by Ch
p rocessi ng st ream SquuBbJAJunDa shirf [J Show Excluded by Chan
subjB_run01 snirf O Subj Plot Type Select Plot Window
g LAIB _runD2.snif Pan LeftRight
ubj
subjC_run01.snirf (O Run Raw Data ::g " HRF < 5 Reset View
subjC_run02. snirf HbT 1
SubjD - v
subjD_runD1. snirf 1 - SEIect G rou p v []Fix X-range
SubjE
subjE_run01. snirf o T 0400
. processing. Two ways .

10 files loaded successfully []Fix Y-range

0 files failed to load to do it. e 22




Group average: example

subjA_run03.snirf
subjB_run01.snirf
subjB_runD2.snirf
subjC_run01.snirf
subjC_run02.snirf
subjD_run01.snirf
subjE_run01.snirf
subjE_run02.snirf

same folder,

oup

provided they have
the.proper name
nomenclature

9]

10 files loaded successfully
0 files failed to load

1 Conc

Edit Options | Applyto all

[[] Show Excluded Auto
[] Show Excluded by Chan

Plot Window
Pan Left/Right

a5

Reset View

(4] Homer3 (1.14.2) - Chjdubb\workspacesisubjectsifnirs-course\EXERCISES-CLEANAEX]_Basic_data_analysis\2-group-averaging -
File Tools View
05 -
13 14 14 15 15
04 29 30 31
0.3
r 13 16
0.2
| 1 3 5 1"
0.1 17 19 21 23 25 27
L 1 3 5 7 1
0
-0.1 P2 4 6 8 0 12
18 20 22 24 26 28
-0.2
I 2 4 6 8 10 12
-0.3 | I | | | | | | I | , . \ . \
. .
2 < Note: All subjects »©
0 e: All subjects 8
.
can also be in the
Processing Level Show Excluded Manual [ Exclude Time
subjA_run02.snirf

[JFix X-range
0 400

[JFix Y-range

HbO A [/ HRF
HbR
HbT 1 v‘
v
Aux
aux1 v ‘

2z




Group average: example

4 PlotProbeGUI: (1,14.2) - Cihjdubb\workspaces\subjectsifnirs-course\EXERCISES-CLEAN\Ex1_Basic_data_analysis\2-group-averaging - O X

1«1

B g s sy

Aﬁ'r“ Ay ‘ﬁo.&q; ‘Ad Aﬁuqd Lp ﬁﬁs& & AﬁsAf . Al

t D1 %‘ % D3 % % DS D7 N A‘ D9 & N D11U
“sv D2 %‘ %‘W D4 % %% D6 D8 % %% D10% vzzy D12% %

Scaling ~Time Marks

‘ - ’ Y | + ‘ |ntewa|:|I|

1115 Amplitude : IL' {micro-molars) O Show Hidden Meas

() Show Time Markers
EXIT

Duplicate Plot

We will get back to this dataset tomorrow and
perform more advanced data analysis



